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 STARTING WORD 2013 

 Microsoft Word is a word processing tool for creating different types of documents that are used 
in the work and school environment. The appearance of Microsoft Word 2013 is similar to Word 
2010 but with more enhanced features. It contains a new look for the Word  icon, a custom-
ized Offi ce Background that appears above the Ribbon, live access to your SkyDrive account, an 
option to work in Read Mode, tab text that appears blue when active, the status bar displays in a 
blue background, and many more exciting new features. When you fi rst launch Word, it opens 
with the Recent screen displayed. This screen allows you to create a new document from either a 
blank document or from a template. And when you exit a document and later return, Word 2013 
resumes where you left off. 

 Starting Word 

 In this exercise, you learn how to start Word using Windows 8 or Windows 7. 

 For instructional purposes, Windows 8 will be used to begin working in Word 2013. Microsoft 
Windows 8 is the latest operating system that interacts with your desktop, laptop, or touch-screen 
devices, such as a touch-screen monitor or tablet. Steps on using Windows 7 to start Word 2013 
also are discussed. 

 When using Windows 8, the screen you see is called the  Windows Start screen  (see Figure 1-2). You 
can choose which application to begin by using your mouse or, if you have a touch-screen mon-
itor, tap the application you want to begin. The Start screen provides access to mail, SkyDrive, 
Internet Explorer, photos, games, music, video, and of course the latest version of the Microsoft 
Offi ce applications. Tablets with Windows RT and the Offi ce 2013 applications installed can be 
customized the same way as your desktop.  

 If you don’t have Offi ce 2013 installed on your computing device, you can still create, view, and 
perform simple edits on Word documents using an online Word Web App. Offi ce Web Apps are 
available for Word, Excel, PowerPoint, and OneNote. Offi ce Web Apps are launched using a web 
browser, such as Internet Explorer. One of the differences between the Word Web App and the 
Word 2013 application installed on your computer is the number of features available. The Word 
Web App allows you to create, open, and edit documents with only the most basic commands. 
It is a wonderful way to create a simple document and share it. The main advantage of using the 
Word 2013 application installed on your computer is having full access to all the features to create 
a professional-looking document. If you use the Word Web App, you will not be able to complete 
all the exercises in this book, because it does not include all the features we cover. 

 Microsoft has an online storage space referred to as the  Cloud . You are provided with 7 GB of free 
online storage space and are able to share and manage your documents with anyone. Before you 
can use this, you need to create a Microsoft account profi le. Once you create your account, you 
will fi nd it easy to share and manage your documents with others. 

 Windows 8 works seamlessly with Offi ce 2013. In the upper-right corner of the Windows 8 screen, 
it displays your Microsoft account profi le once your account is activated. If you are logged on to 
your Microsoft account, it appears in the same location in each of the Offi ce 2013 applications. 
Microsoft has made it easier for you to continue working on your documents at any computer and 
reminds you where you left off. 

 To begin using Word 2013, locate the Word icon and click the left mouse button or, if you are 
using a touch-screen monitor, tap the icon. 

 If your school is operating on Windows 7, launch Word 2013 by double-clicking the Word pro-
gram icon on your desktop or by choosing Microsoft Word 2013 from the Start menu.  

The Bottom Line



Lesson 14

 When Word is launched, the program opens with the  new  Word 2013 screen (see Figure 1-3). 
On the left side of the screen under Recent, you see a list of documents that have been accessed 
recently. The right window pane displays a blank document page and several templates to create 
customized documents. To create a blank document, click the Blank document page and Word 
will open. 

 The blinking  insertion point  in the upper-left corner of this document is where you begin creat-
ing your text. When you place your cursor near it, the insertion point changes to a large “I,” which 
is called the  I-beam . 

 The lessons in this book are created using the Windows 8 operating system. If your computer is 
running the Windows 7 operating system, some screenshots and steps might appear slightly dif-
ferent than those provided in this book. 

STEP BY STEP  Start Word 

  GET READY.  Before you begin these steps, be sure to turn on and/or log on to your 

computer. 

1.  From the Start screen of Windows 8 (see Figure 1-2), locate Word 2013 and click the 

icon . For Windows 7 users, locate the Windows task bar, click the  Start   button, 

and then click  All   Programs . A menu of installed programs appears. Click the  Microsoft 

Offi ce  folder. Next click  Microsoft   Word   2013 . The new Word 2013 screen opens. 

Take Note

Figure 1-2

New Start screen

Microsoft

Account Sign in
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2.  The new Word 2013 screen appears (see Figure 1-3). On the left side of the screen, 

you see the recent documents that have been accessed, and the right side displays the 

blank document page and templates. 
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  PAUSE. LEAVE  the Word 2013 screen open to use in the next exercise. 

Recent Opened

Documents screen

Sample

Templates

Search for online templates box Help

Figure 1-3

Word 2013 window

 Windows 8 and Windows 7 are for PC users at home, work, and school. Both are powerful tools 
that control the user interface, storage devices, other softwares, peripheral devices, networks/securi-
ty, system resources, and task scheduling. Windows 8 is the latest operating system standard for 
computers, laptops, and tablets. Windows 8 also comes in multiple versions, such as Windows 8 
Pro and Windows RT to support your personal needs and how you use your device. Windows 8 
is an improvement on Windows 7 that supports touch-capable devices in addition to traditional 
mouse and keyboard commands. You can get started with Windows 8 by practicing using the 
Narrator. On the keyboard, press the  Windows logo  key plus  Enter . To Exit the Narrator, press 
 Caps Lock 1 ESC . 

 WORKING WITH TOOLS  

 The Word 2013 window has many onscreen tools to help you create and edit documents quickly 
and effi ciently. In this section, you learn how to locate and use the Ribbon, the Mini toolbar, and 
the Quick Access Toolbar to access Word commands. A  command  is an instruction based on the 
action that you give to Word by clicking a   button or entering information into a command box. 
You also learn how to use  Access keys , a tool that enhances the keyboard shortcuts and appears as 
small letters on the Ribbon. Access keys are also known as  KeyTips . 

 Using the Ribbon 

 In Word 2013, the  Ribbon  contains multiple commands separated by  tabs . Microsoft has repre-
sented each of its Offi ce application with a color. Word is symbolized with the color blue and active 
tab text is blue—this is one of the new features in Word 2013. In turn, each tab contains several 

Take Note

The Bottom Line

Another Way
For Windows 7 

users, when Offi ce was 
installed on your computer, a 
shortcut icon might have been 
added to the Start menu or to 
your desktop. Double-click the 
shortcut icon on your desktop 
to start Word without having to 
go through the Start menu.

Another Way
In Windows 7, you 

can use the Search Programs 
and Files box, type Microsoft 
Word 2013 and press Enter. 
You can also search for a 
program or fi le by clicking the 
Start button and then typing 
the fi rst two characters of the 
program or fi lename into the 
Search box; fi les and programs 
beginning with those letters 
appear in the Start menu. By 
right-clicking on the Word 2013 
icon, you can pin Word 2013 to 
the Start menu and task bar, so 
that it is always visible.
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 groups ,   or collections   of related Word commands. For example, in the Home tab, the grouping 
levels consist of Clipboard, Font, Paragraph, Styles, and Editing. Each group contains one or more 
command boxes that have a drop-down  menu  ,  or list of options, associated with them; you click 
the drop-down arrow to produce this menu. Some groups have a  dialog box launcher —a small 
arrow in the lower-right corner of the group—that you click to launch a  dialog box  that displays 
additional options or information you can use to execute a command.  

 In this exercise, you learn to use the Ribbon by making tabs active, hiding and displaying com-
mand groups, and using the dialog box launcher and drop-down arrows. 

 In the Offi ce 2013 programs, the Ribbon is contextual, which means it displays commands related 
to the type of document or object that you have open and onscreen. 

 STEP BY STEP Use the Ribbon 

GET READY. Start with the File > New screen open.

1.  Click the Blank document icon. The Ribbon is located at the top of the Word screen. In 

your newly opened document, the Home tab is the default tab on the Ribbon, as shown 

in Figure 1-4. Note how the Ribbon is divided into groups: Clipboard, Font, Paragraph, 

Styles, and Editing. 

Collapse

the Ribbon

Dialog box launcher

Groups of commands

Drop-down arrows

in command boxTabs

Figure 1-4

The Ribbon

2.    Review the other tabs on the Ribbon and review each group associated with the tab, 

and identify the arrows that launch a dialog box (if present). 

3.    Click the  Page Layout  tab to make it the active tab. Notice that the groups of commands 

change. The Page Layout tab contains three groups: Page Setup, Paragraph, and 

Arrange. Notice that in the Page Setup and Paragraph group a small arrow appears in 

the lower-right corner. Clicking on the arrow opens the dialog box with more options to 

select or complete a command. 

4.    Click the  Home  tab. 

5.    Click the  dialog   box   launcher  in the lower-right corner of the Font group. The Font 

dialog box, as shown in Figure 1-5, appears. The Font dialog box contains two tabs 

with the Font tab being the active tab. There are many options to select within the Font 

dialog box. Click  Cancel  to close the dialog box. 
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6.    Click the drop-down arrow on the Font command box in the Font group to produce a 

menu of available fonts, as shown in Figure 1-6. 

Another Way
Also you can locate 

a font quickly by typing the fi rst 
three characters of the name in 
the Font command box.

Figure 1-5

Font dialog box

Figure 1-6

Font menu

Use scroll bar or buttons

to view additional fonts

Clicking on the drop-down arrow

produces available fonts to select

7.    Click the arrow again to close the menu. 

8.    Double-click the  Home  tab. Notice the command groups are hidden to give you more 

screen space to work on your document. 

9.    Double-click  Home  again to redisplay the groups. 

PAUSE. LEAVE the document open to use in the next exercise.

Another Way
To unclutter the 

screen, press the ^ key located 
above the vertical scroll bar 
in the right corner or press 
Ctrl1F1. Holding the Ctrl while 
pressing F1 is a toggle key, 
which hides the Ribbon and 
then displays the Ribbon.
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 Using the Mini Toolbar 

 In this exercise, you learn to use the  Mini toolbar ,   a small toolbar with popular commands that 
appears when you point to selected text. The Mini toolbar displays after text has been selected. 
You also learn to display the  shortcut menu , which contains a list of useful commands. To display 
the shortcut menu, right-click on selected text. If you are familiar with the Mini toolbar, you will 
notice that new commands have been added to the Mini toolbar. 

STEP BY STEP  Use the Mini Toolbar 

  USE  the document that is open from the previous exercise. 

1.  Type the term  mini toolbar  into your blank document. Drag the mouse pointer over 

the word “toolbar” to select it. The Mini toolbar appears once the word is selected, as 

shown in Figure 1-7. 

Figure 1-7

Mini toolbar

2.    Point to the Font command on the Mini toolbar. 

3.    Click the drop-down arrow on the Font command box. A font menu appears. Press  Esc  once 

or click the drop-down arrow again to exit the command box. To close the Mini toolbar, click 

anywhere in a blank area within the document. 

4.    Now, position the insertion point on the selected text and right-click; the Mini toolbar 

appears, accompanied by a shortcut menu that displays a variety of commonly used 

commands (see Figure 1-8). 

5.    Click anywhere in a blank area of the document to close the Mini toolbar. Drag your 

mouse over the text you typed at the beginning of this exercise to select the text. Press 

the  Delete  key to remove the text. 

Figure 1-8

Mini toolbar and 
shortcut menu

  PAUSE. LEAVE  the document open to use in the next exercise. 
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 Using the Quick Access Toolbar 

 The  Quick Access Toolbar  is located above the Ribbon and contains commands that users’ ac-
cess most often, such as Save, Undo, and Redo—by default, the Save, Undo, and Redo commands 
display when you launch Word 2013. You can customize the contents of the Quick Access Toolbar 
by clicking the drop-down arrow on the right side of the toolbar and choosing options from the 
menu that appears. Microsoft has added the option Touch/Mouse Mode to the Quick Access 
Toolbar for Word 2013. If you have a touch-capable device, you can use Touch Mode. Touch 
Mode provides more space between buttons and icons to prevent you from accidently pressing one 
with your fi nger or stylus. In this exercise, you learn to customize the Quick Access Toolbar. You 
also learn to change its position in relation to the Ribbon. 

 Clicking the  Save  button in the Quick Access Toolbar for the fi rst time opens the Save As 
screen.  Save As    also appears as a command listed in Backstage view when you click the File 
tab. When saving a document for the fi rst time, you need to specify the fi lename and location 
where the document will be saved. You can save a document to your fl ash drive, SkyDrive, 
computer, or any other portable device. After you select a save location, such as your computer, 
the Save As dialog box lets you select a fi le format. The  Undo   command lets you cancel 
or undo your last command or action. You can click the Undo command as many times as 
necessary to undo previously executed commands. Also, if you click the arrow beside the 
Undo command, a history of actions you can undo appears. Clicking the  Redo   command 
repeats your last action. Note that commands on the Quick Access Toolbar are not available 
if their button is dimmed. 

 STEP BY STEP  Use the Quick Access Toolbar 

  USE  the document that is open from the previous exercise. 

1.  Click the  Save   button on the Quick Access Toolbar. 

2.    If this is the fi rst time you’ve attempted to save this document, the new Save As opens 

in Backstage. You have three options for where to save your work: SkyDrive, Computer, 

or  1 Add a Place. For now, you are just exploring the Save command on the Quick 

Access Toolbar. Later in the lesson, you learn to save a document using the Save As 

command. 

3.    Click the  Return to Document  icon, which is a circled left arrow  located in the 

upper-left corner or press the  Esc  key to return to the document screen. 

4.    Click the drop-down arrow on the right side of the Quick Access Toolbar. A menu 

appears as shown in Figure 1-9. Selecting one of the commands automatically places 

the command on the Quick Access Toolbar or moves the Quick Access Toolbar to a 

new location. 

Another Way
Press Ctrl1Z to 

use the Undo command. Press 
Ctrl1Y to repeat your last 
command.
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5.    Click  Show   Below   the   Ribbon . Notice that the toolbar is moved below the Ribbon. 

6.    Click the drop-down arrow on the right side of the Quick Access Toolbar again. Click 

 Show   Above   the   Ribbon  to return the toolbar to its original position. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 In Lesson 14, you learn to further customize the toolbar by adding buttons for other commands 
you use often. 

 Using Access Keys 

 In Word 2013, Access keys allows you to launch a command with keystrokes. Access keys are also 
known as  KeyTips . Every command on the Ribbon and the Quick Access Toolbar has an Access 
key. To display Access keys, press the  Alt  key; KeyTips appears in small black letters across the tab. 
The Quick Access Toolbar has numbers hovering over their associated commands. In this exercise, 
you learn to display KeyTips and use Access keys. 

 STEP BY STEP  Use Access Keys 

  USE  the document that is open from the previous exercise. 

1.  If necessary, Click the  Home  tab. Press the  Alt  key. KeyTips appears on the Ribbon and 

Quick Access Toolbar to let you know which key to use to access specifi c commands or 

tabs (see Figure 1-10). 

Cross 
Ref

Figure 1-9

Customizing the Quick Access 
Toolbar

A check mark indicates the command appears

on the Quick Access Toolbar

How do you customize the 
Quick Access toolbar?

1.4.3
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2.    Press  H  to activate the Home tab. 

3.    Press  PG  to open the Paragraph dialog box, and then click  Cancel . 

4.    Press the  Alt  key again to display the KeyTips. 

5.    Press  P  to activate the Page Layout tab. 

6.    Press  O  to display the options to change the page orientation. 

7.    Press the  Alt  key twice to display the KeyTips again, and then press the  Alt  key to turn 

them off. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 Shortcut keys are keys or are a combination of keys pressed together to perform a command. 
Shortcut keys provide a quick way to give commands without having to take your hands from the 
keyboard. Keyboard shortcuts from previous versions of Word that began with Ctrl have remained 
the same, such as Ctrl 1 C (copy) and Ctrl 1 V (paste). However, Offi ce 2007 introduced Access 
keys, which begin by pressing the Alt key. Later in the lesson, you learn to use Help to learn more 
about keyboard shortcuts. 

Take Note

Figure 1-10

Access Keys

Press the ALT key on keyboard to

activate. To turn off, press the ALT

key again. Each letter is associated

with the tab on the Ribbon

 SOFTWARE ORIENTATION 

 Backstage Screen 

 Before you begin working in Backstage, you need to be familiar with Microsoft’s Offi ce new 
UI. When you fi rst launch Microsoft Word 2013, open a document, and click the File tab, you 
should see a screen similar to that shown in Figure 1-11. This is what is known as  Backstage view . 

Return to

Document icon

Backstage

commands

 Figure 1-11 

 Backstage—The New Open screen 

 Use Figure 1-11 as a reference throughout this lesson as well as the rest of this book. 
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 OPENING BACKSTAGE  

  Backstage   view  offers quick access to commands for performing many fi le management tasks—
such as opening, closing, saving, printing, and sharing Word documents.  

 The new appearance for Backstage displays the command pane on the left side. These commands 
allow you to open, save, print, share, and export documents; to display accounts; and to customize 
options within Word 2013. 

 Here is a brief overview of the commands that appear in the Backstage of Word 2013: 

•   Info:  The options in this group prepares and mark documents as fi nal so that no changes can be 
made to them; protects documents with a password or restricted permissions; protects integrity 
of the document by adding a digital signature; checks the document for sensitive information; 
checks document accessibility and compatibility; and manages different versions of a document. 
The Document Properties can also be opened from this command. 

•   New:  Creates a new document from a blank page or template. 

•   Open:  Displays recently opened locations where documents were saved for quick access. 

•   Save:  Saves the current document using the Word format and location you chose when you last 
used the Save As command. 

•   Save As:  Enables you to save a document in multiple locations, such as your computer, fl ash 
drive, SkyDrive, or desktop area. This command also saves a document in a different fi le format 
(e.g., .pdf, .txt, .rtf, .htm, and so on). 

•   Print:  Offers several sets of options—the  Print  options enable you to send documents straight 
to a default printer and choose the number of copies to be printed; the Printer options enable 
you to choose a printer and set printer properties; the  Settings  options enable you to change the 
settings for a page, and the  Preview  screen enables you to visually check your document for 
errors before printing. 

•   Share:  Allows documents to be shared with family, friends, and colleagues by using SkyDrive, 
e-mail, presenting online, or publishing links on a blog post or social networking page. 

•   Export:  Documents are saved in a PDF, XPS, or another type of format. 

•   Close:  Closes an open document (the program remains open). 

•   Account:  Displays how you can access your documents from any account and how information 
is shared via Flickr, Facebook, LinkedIn, and Twitter. Accounts must be activated to be viewed. 

•   Options:  Includes the default Word document and setting options. The settings for Word 
can be changed in general options, document proofi ng options, save options, language pref-
erences, editing options, and options for managing add-ins and templates and for keeping 
documents secure. 

 STEP BY STEP  Use Backstage View 

 As you begin this exercise, you should acquaint yourself with the new appearance to 

Backstage. In this exercise, you access Backstage by clicking the File tab. To return to your 

document screen, click the Return to Document icon circled left arrow  or press the  Esc  key. 

  USE  the document that is open from the previous exercise. 

1.    Click the  File  tab (see Figure 1-11). 

2.    The default setting Info screen is automatically displayed. 

3.    Click each of the other commands in the left pane to view the options of each one. 

4.    Click  Return to Document  , which is a circled left arrow   icon or press the  Esc  key to 

exit Backstage. This action returns you to the document screen. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

The Bottom Line

Another Way
You can also 

activate Backstage view by 
pressing Alt1F. Using this 
shortcut opens the Access keys 
in Backstage.
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 You learn about Backstage options in Lesson 13. 

 USING THE MICROSOFT WORD HELP BUTTON  

 Microsoft Word 2013 has options for accessing the Help features by pressing  F1  or clicking the 
question mark  in the upper-right corner of the screen. You can access help from Offi ce.com 
or from your computer. 

 When you hover over a command on the Ribbon, a  ScreenTip  appears displaying the name of the 
command and additional information about the command. You also can click the Help button 

 to get more information and advice. 

 Using the Help Button 

 Microsoft Word Help works much like an Internet browser and has many of the same buttons, 
such as Back, Forward, Home, Print, and Use Large Text for easier reading. To access Help, press 
F1 or click the question mark located in the upper-right corner of the screen. A quick way to fi nd 
Help information is to type a word or words into the search box and then click the  Search  button. 
Word displays a list of popular searches as links—to access that topic click the link. Under Getting 
Started are more links to videos, training, tips for tablets, and more. In this exercise, you learn to 
open Word Help and to use Help by typing in search words. 

 The Help screen displays content available online (you must be connected to the Internet to access 
this content, which is located on Offi ce.com). The advantage of being connected to the Internet is 
that you will have access to the latest articles, videos, and training when using the Help command. 
You can print Help information within the Word Help main window by clicking the Print button 
and pin the information to the Help screen to refer back to it quickly. 

 STEP BY STEP  Use the Help Button 

  USE  the document that is open from the previous exercise. 

1.  Make sure you are connected to the Internet. 

2.  Click the  Microsoft Word Help   button in the upper-right corner of the screen or 

press  F1 . The  Word Help  window appears, as shown in Figure 1-12. 

The Bottom Line

Take Note

Back

Pin help

Print

Quick links to

specific topics

Search box

Forward Home Use Large Text

Use Help from Office.com or

from your computer

Figure 1-12

Word Help window

Cross 
Ref
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3.  Under the section, “Getting started,” click the tile  See what’s new  and review the 

content. Then click the back arrow  to return to the Help menu. 

4.  Click the tile  Keyboard shortcuts , and then click   1 Show All  and review the information 

displayed. 

5.    Click the  Home   button to return to the main Help screen. 

6.    Click the  Close   button to close Microsoft Word Help. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 CREATING A DOCUMENT 

 You can create a document from a blank page or use a template that is already formatted. When you 
start typing text at the insertion point in a blank document, you have begun to create a Word docu-
ment. As you type, Word inserts the text to the left of the insertion point and uses the program’s de-
faults for margins and line spacing. Word also has a number of tools and automatic features to make 
creating a document easier, including nonprinting characters, AutoComplete, and Word Wrap. 

 When you begin typing text into a document, it is inserted to the left of the insertion point and 
the document is created using the Word defaults for margins and line spacing. The margin de-
faults are set to one-inch top, bottom, left, and right margins; the line spacing is set to 1.08; and 
the spacing after each paragraph is set to 8 points. Later you learn to begin a new document by 
selecting the single-spaced document with the margins set to one inch. 

 Displaying Nonprinting Characters 

 When documents are created, Word inserts  nonprinting characters , which are symbols for cer-
tain formatting commands, such as paragraphs ( ¶ ), indents and tabs ( → ), and spaces ( • ) between 
words. These symbols can help you create and edit your document. By default, these symbols are 
hidden. To display them, click the Show/Hide (¶) button in the Paragraph group of the Home tab. 
When you print your document, these hidden symbols do not appear. In this exercise, you learn 
to display nonprinting characters in Word. 

 STEP BY STEP  Display Nonprinting Characters 

  USE  the document that is open from the previous exercise. 

1.    On the Home tab, in the Paragraph group, click the  Show/Hide  (¶) button to display the 

nonprinting characters in the document. 

2.    Click the  Show/Hide  (¶) button again to hide the nonprinting characters. 

3.    Press  Ctrl + Shift + *  to once again display the nonprinting characters. This time, leave 

Show/Hide on. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 After you create your fi rst document, you see the fi lename on the document title bar, which dis-
plays as  Document1 . Word assigns chronological numbers to all subsequent fi les that you open in 
that session. When you save and name your documents, the name you assign replaces the docu-
ment number name originally assigned by Word. When you close and reopen Word, the program 
begins its chronological numbering at number 1 again. 

 Hiding White Space 

 The  white space  is the space between pages of the document. This appears at the top and bottom of 
each page with the gray area separating the pages. By default, this appears in Print Layout view. You 
can change the view of the document to reduce the amount of gray appearing by double-clicking 
between the pages. In this exercise, you learn to hide and unhide the white space. 

The Bottom Line

How would you turn on 
Show/Hide?

1.4.7
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 STEP BY STEP  Hide White Space 

  USE  the document open from the previous exercise. 

1.  Make sure your insertion point is at the beginning of the document. Place the mouse 

below the Ribbon until you see the ScreenTip  Double-click to hide white space  and then 

double-click. Notice the gray border line representing the white space becoming thinner. 

2.  Place the mouse over the gray border line until you see two arrows again and then 

double-click. This reveals the white space. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 Using AutoComplete 

 The  AutoComplete  feature automatically completes the text of the current date, day of the week, 
and month. When you type the fi rst four characters of the day of the week, a ScreenTip appears 
with a suggestion for the completed text; press Enter to accept the suggestion. AutoComplete 
reduces the amount of time spent typing content or phrases in a document. The AutoComplete 
feature is turned on by default and can be turned off in the Word Options settings. In this exer-
cise, you learn to use Word’s AutoComplete feature. 

 STEP BY STEP  Use AutoComplete 

  USE  the document open from the previous exercise. 

1.      Type the name of the current month; as you type the fi rst four characters, a ScreenTip 

appears. Press  Enter  to accept the suggested text. 

2.    Press the  Spacebar  and the current day and year appears, and then press  Enter  .  

  PAUSE. LEAVE  the document open to use in the next exercise. 

 Entering Document Text 

 Entering document text is easy in Word. Word sets default margins and line-spacing measurements 
for newly created documents, and  Word Wrap  automatically wraps text to the next line as it reach-
es the right margin. To separate paragraphs and create blank lines, press  Enter . In this lesson, you 
create a letter using the Block Style format with mixed punctuation. Be sure to type the document 
text exactly as shown in the steps that follow—in a later lesson, you learn to format the document. 

 When sending professional correspondence to customers, it is good business practice to ensure 
the document is in an acceptable format and error free. The Block Style letter format has open or 
mixed punctuation and is common to many business documents.  Block Style  format aligns text 
along the left margin, including the date, inside address, salutation, body of the letter, closing, and 
signature.  Open punctuation  requires no punctuation after the salutation or the closing, whereas 
 mixed punctuation  requires a colon after the salutation and a comma after the closing. 

STEP BY STEP  Enter Document Text 

  USE  the document that is open from the previous exercise. 

1.    The insertion point should be positioned at the end of the year. Press  Enter     twice.  

2.    Type the delivery address as shown: 

  Ms. Miriam Lockhart  (Press  Enter    once .)  

  764 Crimson Avenue  (Press  Enter  once .)  

  Boston, MA 02136  (Press  Enter  twice .)  

Another Way
To use AutoCom-

plete, you can also type the 
fi rst four characters of the 
current day of the week, and 
then press Enter or F3.
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3.    Type  Dear Ms. Lockhart:  

4.     Press  Enter  once . 

5.    Type the following text and press  Enter     once after each paragraph.  

     We are pleased that you have chosen to list your home with Tech Terrace Real Estate. 
Our offi ce has bought, sold, renovated, appraised, leased, and managed more homes 
in the Tech Terrace neighborhood than anyone and now we will be putting that 

experience to work for you.  

    Our goal is to sell your house quick for the best possible price.  

     The enclosed packet contains a competitive market analysis, complete listing data, a 
copy of the contracts, and a customized house brochure. Your home has been input 
into the MLS listing and an Internet ad is on our website. We will be contacting you 

soon to determine the best time for an open house.  

     We look forward to working with you to sell your home. Please do not hesitate to call 

if you have any questions.  

6.    Press  Enter  once. 

7.    Type  Sincerely,  

8.    Press  Enter  twice. 

9.    Type  Steve Buckley . Your document should appear as shown in Figure 1-13. This letter 

still needs to be formatted in an accepted mailable format and this is discussed in a 

later lesson. 

Figure 1-13

Block Style format with mixed 
punctuation

Current date will

appear here

  PAUSE. LEAVE  the document open to use in the next exercise. 

How do you create a new 
document? 

1.1.1
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 To create a new blank document, click the  File  tab and then click the  New  command. Select the 
fi rst option,  Blank document , and Word 2013 automatically opens a new document. You can also 
open a new blank document using the keyboard shortcut  Ctrl 1 N . 

 It is always important to save your document before closing the program. However, if you close 
the document or Word by accident, a prompt appears, asking whether you want to save your 
document. Choose  Yes  to save and close,  No  to close without saving, or  Cancel  to stop the Close 
command. The Spelling & Grammar commands are discussed in a later lesson. 

 SAVING A DOCUMENT 

 By default, newly created documents are saved with a specifi c fi lename closely related to the content 
of the document so that you can locate the fi le quickly. After editing an existing document, you can 
choose to save that document with a new fi lename, fi le format, or in another location. When saving 
a document to the Cloud, such as SkyDrive, you have access to your documents at any computer 
or tablet and can share them with others. In some cases, you might want to save the original and 
edited documents in the same place but with different fi lenames. Keeping the original document 
allows you to reference it at a future date on any computer. 

 Saving a Document for the First Time 

 When saving a document for the fi rst time, you must specify a fi lename, the fi le type, and a place 
where you can access the document. The fi lename should help users fi nd and identify the fi le, and 
the fi le location should be convenient for the fi le’s future users. You can save fi les to portable stor-
age devices such as a fl ash drive, to your computer’s desktop or hard drive, to a network location, 
or to SkyDrive. Word 2013 enhanced the Save As command, which allows users to save their work 
to the cloud and access the document quickly from any computer or tablet. In Lesson 13, you 
learn to save documents to SkyDrive. In this exercise, you learn to save a document with a specifi c 
fi lename to your fl ash drive. 

STEP BY STEP  Save a Document for the First Time 

  USE  the document that is open from the previous exercise. 

1.  If necessary, connect your fl ash drive to one of the USB ports on your computer. 

2.  Click the  File  tab, and then click the  Save As  command. The new Save As screen 

is shown in Figure 1-14. There are three options available to save your document: 

SkyDrive, Computer, and  1 Add a Place. Click  Computer . The right side of the screen 

changes and displays Recent Folders that have been opened. 

Take Note

The Bottom Line
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3.  Click  Browse . The  Save As  dialog box opens. In the Windows 8 environment, the 

Documents Library is the default location for saving new fi les. Change the location from 

the default to your fl ash drive by using the vertical scroll bar and scrolling down until 

you see your fl ash drive. Storage devices are given a specifi c letter identifi ed by the 

operating system. For example, your fl ash drive might be labeled as  TravelDrive (I:) . 

4.  Click the  fl ash drive  to open that location to save your document. 

5.  Type  Tech Terrace Letter  in the File name box and click  Save . By default, the fi rst few 

characters that you typed in your document appear in the File name box. Drag the 

mouse over the text and press  Delete  or begin typing over the highlighted text. 

6.  If a prompt appears to upgrade to the newest format click the  OK  button. This action 

allows you to use the new features in Word 2013. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 It is a common business practice to send documents as an attachment through e-mail. When 
documents are opened as an attachment, they open in Protected view. Protected view is covered 
in greater depth in Lesson 13. 

 Saving a Document in a Folder 

 Folders help you organize the documents you create in Word. The documents that you open for 
Word 2013 are organized in folders by lesson. To help you manage documents for this lesson, you 
create a folder in your fl ash drive. You can also create a folder within a folder, and the new folder 
is called a  subfolder . Always remember to check the full location path listed in the Save As address 
bar to be certain that you have identifi ed the right location. In this exercise, you create a new folder 
on your fl ash drive and save the document in that folder with its original fi lename. 

Another Way
You can also save a 

document by clicking the Save 
button on the Quick Access 
Toolbar or by pressing Ctrl1S.

Cross 
Ref

Figure 1-14

The New Save As screen

Return to

Document icon

Recent Folders displayed from Computer

Browse button

Options on where to save your work,

such as your Desktop, hard drive, or portable device

Backstage

commands
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STEP BY STEP  Save a Document in a Folder 

  USE  the document that is open from the previous exercise. 

1.  Click the  File  tab, and then click  Save   As . 

2.  Click  Computer . Under the Computer heading, you should see your fl ash drive under 

Current Folders. Click your fl ash drive—the  Save As  dialog box opens. 

3.    Click  New   folder  located below the address bar and type  Word   2013 . Press  Enter . 

4.    In the main pane of the dialog box, double-click the  Word   2013  folder; notice the 

address bar displays your fl ash drive followed by  Word 2013 , as shown in Figure 1-15. 

Note also that the fl ash drive TravelDrive (I :) in Figure 1-15 might not appear on your 

screen; therefore, you need to check with your instructor for the correct path.  Tech 

Terrace Letter  should already appear in the File name box. 

Figure 1-15

Save As dialog box in a 
specifi c folder

Flash drive location

Click to create new folder

Address bar displays location

of flash drive and folder

5.    Click  Save  to close the dialog box. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 AutoRecover is a feature that automatically saves your data at scheduled intervals. Be default, 
Word 2013 saves your work every 10 minutes. This makes it possible to recover some of your 
work if a problem occurs. However, this useful option is not a substitute for frequently saving 
your documents as you work. You should always click the  Save  button regularly to avoid losing 
work in case of a power outage or computer crash. 

Troubleshooting
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 Saving a Document with a Different Name 

 You can use the Save As command to save a copy of your document with a new fi lename, to save 
the document in a new location, or to save the document as a different fi le type. In this exercise, 
you learn to save an existing document with a new fi lename in the Word 2013 folder. 

STEP BY STEP  Save Document in a Folder with a Different Name 

  USE  the document that is open from the previous exercise. 

1.  Click the  File  tab, and then click the  Save As  command. On the right side of the screen 

under Current Folder, you should see the folder that you created. 

2.      Click  Word 2013  and the  Save As  dialog box opens. 

3.    Type  Tech Terrace2  in the File name box. 

4.    Click  Save . 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 Showing File Extensions 

 Word gives you the option of saving your document in a number of formats considered as non-na-
tive fi le types (see Figure 1-16), such as a Word template, web page, Rich Text Format, and PDF 
(Portable Document Format) fi le, which safeguards the document and preserves the intended 
formatting for viewing and printing. A document’s fi le type is embedded in the fi lename as a fi le 
extension. A document saved with one of the fi le types shown in Figure 1-16 can be opened and 

Another Way
The Save As dialog 

box can also be opened by 
pressing F12. To locate your 
fl ash drive, click the drop-down 
arrow beside the address bar at 
the top of the dialog box, and 
then scroll through the listings 
and click the fl ash drive.

Figure 1-16

File type formats

The Save as type

produces a listing

of different file types



Understanding Word 21

STEP BY STEP  Show File Extensions in Windows 8 

  USE  the document that is open from the previous exercise. 

1.  Hover the mouse in the upper-right edge of the screen until the Windows 8 Charms 

appear on the right side of the screen (see Figure 1-17). Another way to display the 

Windows 8 Charms is to press the keyboard combination  Windows logo key +  C . The 

Windows logo key is located on the keyboard.  

File Type Description

Word Document (*.docx) Used for Microsoft Word 2007, 2010, and 2013.

Word 97-2003 (*.doc) Used for Microsoft Word 97-2003.

Word Template (*.dotx) Template for Microsoft Word 2007, 2010, and 2013.

Word 97-2003 Template (*.dot) Template for Microsoft Word 97-2003.

PDF (*.pdf) Portable Document Format, which preserves the intended formatting of a fi le for 

later editing, viewing, and printing. PDF fi les open with Adobe Reader. In Word 

2013, you can edit PDF documents.

XPS Document (*.xps) XPS is a fi le format that preserves document formatting and enables fi le sharing.

Web Page (*.htm,*.html) Both extensions denote HTML fi les, which is an acronym for the Hypertext Markup 

Language format. These type of documents open in a web browser.

Rich Text Format (*.rtf ) RTF documents are opened with text editor programs such as Notepad, WordPad, 

and Microsoft Word. Only limited formatting is allowed.

Plain Text (*.txt) Plain text documents are associated with Notepad, WordPad, and Microsoft Word. 

The .txt extension does not permit formatting other than spaces and line breaks.

OpenDocument Text (*.odt) Used by some word processing applications such as OpenOffi ce.org and Google.

docs. Some Microsoft Word formatting might be lost when fi les are saved in the 

.odt format.

Table 1-1

File Extensions

edited in Word. File extensions are associated with certain programs. (The Save as type drop-
down list shows the fi le type formats available in Windows 8 and Windows 7, and Table 1-1 
provides a description for some of the fi le extensions.) In this exercise, you learn how to display fi le 
extensions in Windows 8 and in Windows 7. 
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2.  Click the  Settings   icon. A command pane appears on the right side. 

3.  Under Settings, click  Control Panel . The Control Panel opens. The Control Panel 

contains a menu bar. (If the menu is not visible, press the ALT key to display the menu). 

4.  Click  Tools  on the menu bar. 

5.  Click  Folder options . The  Folder Options  dialog box opens with the General tab as the 

active tab. 

6.  Make the  View  tab active by clicking on the tab. 

7.  Under the Files and Folders heading, locate  Hide extensions for   known fi le types  and 

then click in the check box to remove the check mark. By default, the fi le extensions 

are hidden. When the check mark is removed, the fi le extensions will be displayed on 

the title bar each time you open a new document. Note, the document that is opened, 

needs to be closed and reopened to see the fi le extension associated with Word 2013. 

8.  Click  OK  to close the  Folder Options  dialog box, and then click the  Close   button to 

close the Control Panel. 

  PAUSE.  The Word program is still open from the previous exercise. 

Another Way
In Windows 8, fi le 

extensions are off. If the fi le ex-
tensions on your computer are 
hidden, you can show them in 
Windows 8. Click the Windows 
8 Search charm. Type Control 

Panel. Select Control Panel . 
Tools . Folder options . View 

tab. Clear the check box by 
Hide Extension for known fi le 
types.

Figure 1-17

Windows 8 commands on the 
Charm Bar.

Search

Share

Start

Devices

Settings

Charms
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STEP BY STEP  Show File Extensions in Windows 7 

  USE  the document that is open from the previous exercise. 

1.    Click  Start . In the Search box, type  Show hidden fi les and folders . 

2.    Click  Show hidden fi les and folders  under the Control Panel. 

3.  The  Folder Options  dialog box appears. Click the  View  tab, and then clear the  Hide 

extensions for known fi le types   check box . In some cases, the System Administrator 

who manages the lab environment might set up the computers in the lab so that each 

computer system displays the same. Check with your instructor to see whether the fi le 

extensions will display on your computer. 

4.  Click  OK  to close the dialog box. 

  PAUSE.  The Word program is still open from the previous exercise. 

 Choosing a Different File Format 

 Some individuals and companies might have not upgraded their Offi ce suite to the latest version of 
Offi ce 2013 and might still be working in an earlier version, such as Word 2003. Changing the fi le 
format of a document allows those individuals and companies to open and edit your document with-
out losing its text formatting. In this exercise, you learn to save a document in a format compatible 
with an earlier version of Word. 

STEP BY STEP  Choose a Different File Format 

  USE  the document that is open from the previous exercise. 

1.  Click the  File  tab, and then click  Save   As  to open the Save As screen. 

2.  Under Current Folder, click  Word 2013 . The folder you created earlier opens. 

3. In the Save as type box, click the drop-down arrow and choose Word 97-2003 

Document (*.doc).

4.  Type  Tech Terrace2 97-2003    in the File name box. Click  Save .  You should see the .doc 

extension in the File name box—the fi le extension is associated with a previous version 

of Word. On the title bar, the fi le extension appears along with Compatibility Mode. In 

the next exercise, you learn about Compatibility Mode.

  PAUSE. LEAVE  document open for the next exercise. 

 Converting a Document 

 Compatibility Mode enables you to work in a document created in an earlier version of Word 
without saving the fi le in a different fi le format. In this exercise, you learn to use the Convert com-
mand to clear the compatibility options and convert a document to the Word 2013 fi le format. 

STEP BY STEP  Convert a Document 

  USE  the document that is open from the previous exercise. 

1.  With the  Tech Terrace2 97-2003.doc  document open, click the  File  tab. 

2.  In the main pane of the Info command, click  Convert , and then click  OK  to confi rm the 

conversion, as shown in Figure 1-18. Converting the document clears the Compatibility 

Mode on the title bar and upgrades your document to Word 2013 format, which allows 

you to access Word’s new features. 

Another Way
By default, fi le 

extensions are off. If the fi le 
extensions on your computer 
are hidden, you can show them 
in Windows 7 using two differ-
ent methods. Either choose 
Start . Control Panel .
Appearance and Personal-

ization . Folder Options 
or choose Start, type folder 
options in the Search box, and 
press Enter.

How do you save a document 
in a different fi le format? 

1.5.2
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3.  To save the document in the Word 2013 fi le format, click the  File  tab. 

4.  Click  Save As , and then click the  Word 2013  folder. Then in the File name box, type 

 Tech Terrace Update . Click Save. The fi lename displays the .docx extension in the title 

bar after the fi le name. 

  PAUSE. LEAVE  the document open for the next exercise. 

STEP BY STEP  Export a Document to a PDF 

  USE  the document that is open from the previous exercise. 

1.  Now you export the document to a PDF fi le format. Click the  File  tab and click the 

 Export  command. The Export screen opens (see Figure 1-19). You use the Export 

command to share your documents with others. Publishing the document as a PDF fi le 

preserves the formatting. You can also select what you want to share before exporting. 

In Lesson 13, you learn to select what you want to share. 

Figure 1-18

Convert prompt

Click the Create a PDF/XPS button

to open the Save As dialog box

Figure 1-19

Export screen

2.  Click the Create  PDF/XPS  button. The  Publish as PDF or XPS  dialog box opens, and the 

Word 2013 folder automatically opens. 

How do you maintain 
backward compatibility by 
converting a document? 

1.5.7
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3.  In the File name box, type  Tech Terrace 3 . In the Save as type box, notice that the PDF 

(*.pdf) is showing. The fi le extension is automatically selected when using the Export 

command. 

4.  Click  Publish . By default, the document will not open after the fi le is published. To open 

the document in a reader format, enable the  Open fi le after Publishing  check box. 

5.  Click  File , and then click  Close  to close the Word document. 

  PAUSE. LEAVE  Word open for the next exercise. 

 PDF is a popular Save As format for documents and preserves document formatting for viewing. 
Word 2013 now allows editing documents that are saved in a PDF format. In a later lesson, you 
learn to edit a PDF document. To edit in PDF format, you must download the appropriate add-in 
from microsoft.com. 

Take Note

 SOFTWARE ORIENTATION 

 Template Options in Backstage 

 You can work more effi ciently by basing many of your new documents on templates that 
Word provides—there are many choices available for working with different templates, as 
shown in Figure 1-20 (you will likely see a different selection of templates than shown in 
this fi gure). 

Figure 1-20

New screen displaying templates

 Using templates keeps you from having to recreate the layout and formatting of recurring 
documents such as interoffi ce memorandums, monthly newsletters that you share with em-
ployees, recordings of minutes from meetings, and more. The New command has many 
options to select a template of your choice. You can work with templates that are already 
installed or search for a template online. 
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 WORKING WITH TEMPLATES 

 You can choose from many different categories of templates, such as letters, resumes, faxes, labels, 
cards, calendars, and more. Some templates are preinstalled with Word and there are more options 
available online. A  template  is a master document with predefi ned page layout, fonts, margins, 
and styles that is used to create new documents with the same basic formatting. Templates are 
reusable even if you saved the document with a different fi le name. In this exercise, you locate an 
installed template, enter information, and save the document as a template. 

 Locating a Template Installed on Your Computer 

 Microsoft continues to add new templates to its categories. If you are looking for a document that 
contains no formatting, single spaced, margins at one-inch top, bottom, left, and right, then the 
Single spaced (blank) document template will do just that. In this exercise, you select this template 
to create and save a Word document. 

STEP BY STEP  Locate a Template Installed on Your Computer 

  GET READY.  OPEN Word if it is not already open. 

1.    Click the  File  tab, and then click  New . The New screen displays the available templates 

as shown in Figure 1-20. Scroll down and review the accessible templates. First 

determine what type of document needs to be created. For this exercise, you select a 

blank template. 

2.  Click the  Single spaced (blank)  document, and then click the  Create  button. 

3.  Display the Show/Hide button (¶) to show paragraph marks. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 Creating a Document Using a Template 

STEP BY STEP  Create a Single-Spaced Document Using a Template 

  GET READY.  OPEN Word if it is not already open. 

1.    Click the  File  tab, and then click  Save As . In the Save As screen, click  Computer . Under 

Recent Folders, click the  Word 2013  folder to open that location. In the File name box, 

type  Welcome Memo . Click  Save . 

2.  Type the document as follows and press the  Tab  or  Enter  key as indicated. By pressing 

the  Tab  key twice, you are aligning the text at the one-inch marker on the ruler. 

  Forest Hills Home Owner’s Association  [Press  Enter  three times.] 

  To:  [Press  Tab  twice.]  New Neighbor Welcoming Committee Members  [Press  Enter  

twice.] 

  From:  [Press  Tab  twice.]  Committee Chair  [Press  Enter  twice.] 

  Date : [Press  Tab  twice.]  December 15, 20XX  [Press  Enter  twice.] 

  Subject:  [Press  Tab  twice.]  Meeting and Refreshment Schedule  [Press  Enter  twice.] 

 Thank you for volunteering to be on the New Neighbor Welcoming Committee. 
Enclosed please fi nd the meeting and refreshment schedule for the next six months. 

See you in January! 

3.     SAVE  the document leave open for the next exercise. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 Finding Templates on the Internet 

 Microsoft offers numerous templates online and other templates are also available from third-party 
providers, as well as other users in the community. You can select from a category using the Offi ce.
com Templates section or search for a template using the Search bar and searching by keywords. 

The Bottom Line

How would you turn on 
Show/Hide? 

1.4.7

How do you create 
a document using a 

template? 

1.1.2
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You can also use the Help feature and search for additional information on templates on your 
computer or online. You must be connected to the Internet to search for templates online. In this 
exercise, you select a template category and view a listing of templates online. 

STEP BY STEP  Find Templates on the Internet 

  GET READY.  OPEN Word if it is not already open. 

1.    Click the  File  tab, and then click  New . 

2.  In the Search for online templates box, type  forms , and then click the  Start Searching  

 button. Additional templates are displayed as shown in Figure 1-21. You can also 

fi lter the templates by category to narrow your search. Preview by using the scroll bar 

and select any template. Click  Create . 

Figure 1-21

Online templates

Key a category in text box then click

the magnifier to begin search

3.     CLOSE  the forms template and do not save. 

4.  As the assistant to the Tech Terrace Real Estate manager, you are in the beginning 

stages of gathering the materials together for the annual report. You decide to use one 

of the available templates in Word 2013. Click the  File  tab, and then select  New . 

5.  In the Search for online templates box, type  Annual Report (Timeless design) , and then 

click the  Start Searching   button. Select the template with the image, and then click 

 Create . The template will download. 

6.  Complete the placeholders with the following text: type text inside the brackets,  [FY] 

[Year] . Click the drop-down arrow by the year and select the current date—note the 

year displays in the placeholder. As you gather information for the report, you begin 

entering data into the document. 

7.    Click  File , and then click  Save As . In the  Save As  dialog box screen, click  Computer . 

Under Current Folders, select the Word 2013 folder. 
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8.  In the File name box, type  Annual Report . 

9.  Change the fi le type by clicking the drop-down arrow and select  Word Template 

(*.dotx) . Note that you might need to select your fl ash drive again because Word 

automatically saves templates to the Templates folder located on the computer. 

10.  Click  SAVE . 

  PAUSE. LEAVE  the document open for the next exercise. 

 You must be connected to the Internet to view online templates. 

 Workplace Ready 

 USE TEMPLATES TO SAVE TIME AND MONEY 

 Templates are a great tool for helping create documents in the workplace. Companies can create 
professional-looking marketing plans, brochures, invoices, timesheets, and other common docu-
ments directly from the supplied templates. By using the supplied templates, companies can save 
time and money from creating complex documents from scratch.  

 To fi nd additional information on templates, use the Help feature by pressing the  F1  button or 
click the  Help  button. 

 PREVIEWING AND PRINTING A DOCUMENT   

 The Print command is located on the File tab in Backstage. There are three groups of printing options 
available, which are the printing properties and settings. The Preview pane gives you an  opportunity 
to see what your printed document will look like so you can correct errors before printing. 

 Previewing in Backstage 

 Before printing your document, you need to preview its contents so you can correct any text or 
layout errors. In this exercise, you learn to use Backstage to preview your document. 

 The Print command feature includes three sets of options: Print, Printer, and Settings. Choosing 
the Print button automatically prints the document to the default printer using the default set-
tings. Use the selection arrow to change the number of copies to be printed. The Printer options 
enable you to select a printer, print to fi le, or change printer properties. Use the Settings options to 
print only specifi c pages or selections of the document, collate the document, and so on. You also 
have access to Page Setup here, where additional settings can be changed on the document. You 
learn more about changing the document’s layout in Lesson 5. 

 The Preview screen to the right of the Print options settings enables you to view your document 
as it will appear when it is printed, so you can make any necessary changes, such as changing the 
margins or orientation, before printing. The Preview screen lets you preview every page by clicking 
on the right and left arrows to page through multiple-page documents. 

STEP BY STEP  Use Print Preview 

OPEN the   Welcome Memo  document that you created earlier. 

1.    Click the  File  tab, and then click  Print . The Print screen opens with the Print options on 

the left and the Print Preview on the right, as shown in Figure 1-22. 

Another Way
You can double-click 

on a template to open it.

Take Note

Take Note

The Bottom Line
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2.    Click the  plus symbol ( + )  on the Zoom slider located on the bottom-right of your screen 

until the zoom level changes to  100% . 

3.  Click the  Return to Document   icon or press the  Esc  key to close Backstage. 

4.  Click the  File  tab, and then click  Save . Your document will be saved with the same 

fi lename on your fl ash drive. 

  PAUSE  .   LEAVE  the document open to use in the next exercise. 

 You learn more about Page Setup in Lesson 5. 

 Choosing a Printer 

 If your computer is connected to multiple printers, you might need to choose a destination printer 
for your document. If your printer is already set up to print, as is the case in most classroom en-
vironments, you do not need to complete this exercise. Otherwise, follow this exercise to choose 
a printer. 

 Before printing your document, check with your instructor. 

STEP BY STEP  Choose a Printer 

  USE  the document that is open from the previous exercise. 

1.  Click the  File  tab, and then click  Print . 

2.  In the Printer selection area, click the  drop-down arrow  to produce a list of all printers 

connected to your computer (see Figure 1-23). 

Cross 
Ref

Take Note

Print commands

Pages within Document Zoom Slider

Preview area

Figure 1-22

Print options and Print 
Preview screen

How do you prepare a 
document for printing? 

1.5.1
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3.  Select a printer, and then click the  Print  icon.  

  PAUSE. LEAVE  the document open to use in the next exercise. 

 Setting Print Options 

 Print options enable you to select the number of copies to be printed; to print only selected content, 
the current page, or a custom range; and to select from a number of other options for printing prop-
erties, collation, and page layout. Changes to Settings options apply to the current document. In this 
lesson, you learn how to change the Settings options before printing. (Check with your instructor 
before printing this exercise on a lab printer). 

STEP BY STEP  Set Print Options 

  USE  the document that is open from the previous exercise. 

1.  Click the  File  tab, and then click  Print . Click the drop-down arrow on Print All Pages to 

produce the menu shown in Figure 1-24. 

Available printers

Figure 1-23

Available printers

Print options

Figure 1-24

Print settings
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2.    Select  Print   Current Page , and then click the  Print  icon. Selecting this option prints the 

current page. 

3.  Return to the Print screen area. In the Copies section of the Print options area, click the 

up arrow to select  2 , and then click the  Print  icon. 

4.  Place your insertion point at the beginning of the fi rst paragraph, and then hold down 

the left mouse button and drag to the end of the paragraph to select it. 

5.  Click the  File  tab, and then click  Print . Click the  Print Current Page  drop-down arrow, 

select Print Selection, and then change the number of copies from 2 to  1  by clicking the 

down arrow. Next, click the  Print  icon. The selected paragraph is printed. 

6.  Click the  File  tab, and then click  Close  to close the document. 

7.  The Annual Report document should still be open from a previous exercise. Click the 

 File  tab, and then click  Print.  Under Settings, click the drop-down arrow by 1 Page 

Per Sheet and select  2 Pages Per Sheet , and then click the  Print  icon. This eight-page 

document is now printed on four pages with two pages per sheet. 

  PAUSE. LEAVE  the document open to use in the next exercise. 

 CLOSING A DOCUMENT AND CLOSING WORD 

 Closing a document removes it from the screen. It is a good idea to close a document before exiting 
a program or turning off your computer. Saving your work before closing allows you to continue 
working on your document at a later date. 

STEP BY STEP  Close a Document and Close Word 

  USE  the document that is open from the previous exercise. 

1.  Click the  Close   button to close both the document and Microsoft Word. 

  STOP.   

 SKILL SUMMARY 

In This Lesson, You Learned to: Exam Objective Objective Number

Start Word 2013

Work with Tools Customize the Quick Access toolbar. 1.4.3

Open Backstage 

Use the Microsoft Word Help 

Button 

Create a Document Demonstrate how to use Show/Hide.

Create new blank documents.

1.4.7

1.1.1

Save a Document Save document in alternative fi le

  formats.

Maintain backward compatibility.

1.5.2

1.5.7

Work with Templates Demonstrate how to use Show/Hide.

Create new documents and apply 

  templates.

1.4.7

1.1.2

Preview and Print a Document Confi gure documents to print.

Print document sections.

Set print scaling.

1.5.1

1.5.3 

1.5.6

Close a Document and Close Word 

Another Way
You can also print a 

document by pressing Ctrl1P.

The Bottom Line

How do you print document 
sections? 

1.5.3

How do you set print 
scaling?

1.5.6


